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Deal Registration Lifecycle

• Partner fills out Deal 

Registration form on 

the Leads tab or 

registers an existing 

Lead.

• RSA approves or 

rejects Deal 

Registration.

• If rejected, Partner 

can work Lead or 

update and resubmit 

Deal Registration.

• Partner works 

Opportunity.

• Partner requests 

Opportunity closure.

• Channel Manager 

closes Opportunity 

and documents 

win/loss details.



Deal Registration Overview

Deal Registrations originate as Leads

• Deal Registrations are a type of Lead in the PRM Connect Tool

• Approved Deal Registrations are converted to Opportunities upon approval. 

Channel Managers will own Partner Opportunities 

• If the Deal Registration is not approved, Partners can continue working it as a Lead 

or update and resubmit for approval

Improvements to Deal Registration

• Ability to register existing Leads

• Quickly clone a Deal Registration Lead

• Easy navigation to Deal Registrations

• Emails notify Partners when RSA has reviewed a Deal Registration

• Streamlined Deal Registration Form with improved validation



Deal Registration List Views

Deal Registration list views are available on the Leads and Opportunities tabs. 

They provide a quick and easy way to view Deal Registrations. Possible views 

are:

Leads Tab:

• All Deal Registrations: displays all open, pending and rejected Deal Registrations 

for the Partner Account (based on visibility setup) 

• My Deal Registrations – Partners: displays all your open, pending and rejected 

Deal Registrations

• My Pending Deal Registrations: displays all pending Deal Registrations

• My Rejected Deal Registrations: displays all rejected Deal Registrations

Opportunities Tab:

• My Deal Registrations – Partners: displays all approved Deal Registrations



Searching for Deal Registrations

Quickly search for your Deal Registrations using the Advanced Search on the 

Sidebar

System Actions to Search for a Deal Registration:

1. Click on the Advanced Search…link on the Search section of the Sidebar

2. Check the checkbox next to:

• Leads - to search for Deal Registrations that have not yet been approved 

• Opportunities - to search for approved Deal Registrations

3. Enter search criteria into the Search field

4. Click on the Search button
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There are 3 ways to create a Deal Registration:

1. Create a Deal Registration Lead from the Create Deal Registration link on the 

Sidebar

2. Create a Deal Registration using the New button on the Leads tab

3. Register an existing Lead

Deal Registration Origination
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1. Quickly create a Deal Registration using the link on the Sidebar

Submit Deal Registration
Create Deal Registration

System Actions to Create a Deal Registration from the Sidebar:

1. Click on the Home tab

2. In the Useful Links section of the Sidebar, click on the Create Deal Registration link
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2. Create a Deal Registration from the Leads tab

Submit Deal Registration
Create Deal Registration Continued

System Actions to Create a Deal Registration from the Leads Tab:

1. Click on the Leads tab

2. Click on the New button

3. Select Deal Registration from the Record Type of new record picklist

4. Click on the Continue button
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3. Create a Deal Registration by registering an existing Lead

Note: RSA Generated Opportunities may not be eligible for Incremental Deal 

Registration benefits

Submit Deal Registration
Create Deal Registration Continued

System Actions to Register an Existing Lead:

1. Click on the Leads tab

2. Click on the Lead name you want to register

3. Click on the Register Deal button at the top of the Lead page
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Submit Deal Registration
Filling out the Deal Registration Form

The Deal Registration form has been streamlined to capture key information 

Information captured on 

the Deal Registration 

form is carried over to 

the Opportunity.

Required Fields are 

marked with a red bar.



Submit Deal Registration
Filling out the Deal Registration Form

Products entered on the Deal Registration will be locked when the Deal 

Registration is approved 
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The Add – On fields 

allow you to select 

relevant Add – Ons to 

the products you 

selected on the left.

Use the arrows to 

select an Add – On. 
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Submit Deal Registration
Filling out the Deal Registration Form

An individual Deal Registration should be submitted for DLP, enVision and PII 

bundles

Tip: Use the Clone button to create Deal Registrations for multiple products

The Add - On fields 

allow you to select 

relevant products to 

submit with the 

products selected in the 

picklist. Any 

combination of Add -

Ons can be submitted.
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Submit Deal Registration
Filling out the Deal Registration Form

When you are the Primary Contact, check the Same as 

Submitter checkbox to automatically populate your user 

information into this section of the form. Your user 

information will populate when you click on the Save 

button.

If you are not the Primary Contact, enter your name.

If the Deal Registration 

is approved, the 

Projected Value and 

Expected Close Date 

values will carry over to 

the Opportunity.

If RSA has made 

programs available to 

you, the Deal 

Registration can be 

associated with a 

program using the 

magnifying glass icon. 

Please note that the 

program association 

cannot be changed 

once selected. 
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Submit Deal Registration
Save Before Submitting

Deal Registrations must be saved before they can be submitted. Upon saving, 

the PRM Connect Tool will perform validations to confirm the Deal 

Registration meets program rules and guidelines



After saving, the Clone button appears. To quickly copy a Lead, use the clone 

feature:

• Why: When a new Lead is available at the same client

• When: When two Deal Registrations are needed to include separate 

products

Tip: Use the Clone button to create Deal Registrations for multiple products
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Submit Deal Registration
Cloning

System Actions to Clone a Deal Registration:

1. Create and save a Deal Registration

2. Click on the Clone button to copy the entered fields

3. Click on the Edit button to edit the products on each Deal Registration

4. Click on the Save button
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Submit Deal Registration
Add Distributor

After saving, you can add a Distributor to your Deal Registration 

• Why: To automatically notify the Distributor if your deal is approved

• When: Before you submit the Deal registration. You cannot add a 

Distributor to the Deal Registration after it is submitted 

Upon clicking the Add 

Distributor button, 

Distributors will display 

based on the coverage 

country of the Distributor.

In North America, if a Partner 

has nominated a Distributor 

and the Deal Registration 

contains DLP or enVision

products, only the Nominated 

Distributor will be available to 

select.
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Submit Deal Registration
Submit Deal Registration for Approval

When the Deal Registration form is ready for RSA review, click on the Submit 

for Approval button
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Submit Deal Registration
View Deal Registration Status

After submitting a Deal Registration, view the status of the submitted Deal 

Registration in the Approval History related list at the bottom of the Deal 

Registration

Possible status values:

• Pending – RSA is reviewing Deal Registration submission

• Approved – RSA approved the Deal Registration. Deal Registration will be 

converted to an Opportunity

• Rejected – RSA rejected Deal Registration. Deal Registration can be worked as 

Lead or Partner can edit the original submission and resubmit (based on rejection 

reason)



When a Deal Registration is approved, the Lead is converted to an Opportunity

Deal Registration Opportunities can be viewed using the My Deal 

Registrations – Partners list view on the Opportunities tab. A link to the 

Opportunity will display

On the Opportunity, Partners can view the Deal Reg Type and Deal 

Registration Code

Note: It is possible to search by Deal Registration Code in the PRM Connect Tool
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RSA Reviews Deal Registration
Approved Deal Registration



Submit Deal 
Registration

RSA Reviews 
Deal 

Registration

Partner 
Works 

Opportunity

When a Deal Registration is rejected, the rejection reason is captured on the 

Deal Registration. Possible rejections reasons are:

• Already on the RSA Forecast

• Already registered by another partner

• Already registered by the same partner

• Criteria Not Met

Refer to the Deal Reg Rejection Comments field for additional context about 

the rejection 

RSA Reviews Deal Registration
Rejected Deal Registration

• Ineligible Product

• Insufficient License Quantity

• Partner Not Authorized

• Public Sector Rejection

• Reject – Other
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RSA Reviews Deal Registration
Rejected Deal Registration Continued

System Actions to View Rejection Reason:

1. Click on the Leads tab

2. From the View drop-down, select the My Deal Registrations view

3. Click on the Deal Registration you want to view the status for

4. Scroll down to the Deal Status section on the record page



When a Deal Registration is rejected, Partners can:

• Continue to work the deal as a Lead in the PRM Connect Tool

• Edit and re-submit the original submission for approval

Deal Rejections with one of the below rejection reasons can be edited and 

resubmitted:

• Criteria Not Met

• Ineligible Product
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RSA Reviews Deal Registration
Resubmit Rejected Deal Registration

• Partner Not Authorized

• Public Sector Rejection

• Insufficient License Quantity

• Reject – Other
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RSA Reviews Deal Registration
Resubmit Rejected Deal Registration Continued

System Actions to Resubmit a Rejected Deal Registration:

1. Click on the Leads tab

2. From the View drop-down, select the My Deal Registrations view

3. Click on the Deal Registration you want to view the status for

4. Click on the Edit button at the top of the page

5. Make necessary edits. Click on the Save button

6. Click on the Submit for Approval button



When an Opportunity is within 45 days of expiration, a Request Deal 

Extension link will appear on the Opportunity

Partners will also receive an email notifying them of the upcoming expiration 

If approved, the expiration date on the Opportunity will automatically update

RSA Reviews Deal Registration
Requesting an Extension
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Upon clicking the Request Deal Extension link, the Partner enters a request 

justification (required field)

When the Partner saves the information entered, the form automatically 

populates the remaining information from the Opportunity

RSA Reviews Deal Registration
Requesting an Extension Continued
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Highlighted information 

automatically populates
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When the expiration date has passed, the Opportunity will be marked as 

expired

The Partner will receive an email notifying them of the expiration

RSA Reviews Deal Registration
Expired Deal Registration
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When a Deal Registration has passed its expiration date, a Request Deal Re-

Registration link appears on the Opportunity

• The original submitter can click on the Re-Registration link to create a new 

registration for the expired deal

• Clicking the link will take the user back to the Deal Registration page with basic 

information from the original Deal Registration pre-populated

RSA Reviews Deal Registration
Request Deal Re-Registration



When the Deal Registration is converted to an Opportunity, a select set of 

fields are editable:

• Opportunity Name

• Partner Projected Amount
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Partner Works Opportunity
Editable Fields on Opportunity

• Expected Close Date



Click on the Closed – Won button to request that the Opportunity be marked 

as Closed – Won. The Channel Manager will be notified when the Closed –

Won button is selected.

The Channel Manager will close the Opportunity on behalf of the Partner

Close Opportunity
Set Opportunity to Closed - Won
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If an Opportunity should be set to Closed – Lost, Partners should talk with 

their Channel Manager and communicate the status or create a Task on the 

Opportunity and assign it to the Channel Manager

The Channel Manager will close the Opportunity on behalf of the Partner  

Close Opportunity
Set Opportunity to Closed - Won
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Support Resources

RSA Training Materials

• All training materials will be posted to RSA 

Partner Central at: 

http://powerlink.emc.com/km/appmanager

/km/secureDesktop?internalId=0b0140668

049097f 

• Click on link to your region

• Click on PRM Connect Training in the 

Channel Operations section

Cases

• Submit a Case in PRM Connect

1. Log into the PRM Connect Tool

2. Click on the Cases tab

3. Click on the New Case button

http://powerlink.emc.com/km/appmanager/km/secureDesktop?internalId=0b0140668049097f
http://powerlink.emc.com/km/appmanager/km/secureDesktop?internalId=0b0140668049097f
http://powerlink.emc.com/km/appmanager/km/secureDesktop?internalId=0b0140668049097f



